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SpaceClaim 2015 Beta Enhancements Overview 
This release improves SpaceClaim in the areas of STL/faceted modeling, prep for manufacturing and 
simulation, and overall usability, performance, and direct editing.  
 
These enhancements seek to address top customer requests and expand the capabilities of the software 
while maintaining a focus on keeping SpaceClaim easy to use, simple, and fast.  
 
New capabilities in SpaceClaim 2015 include: 

• New tools for editing stl and other faceted file formats. Specifically: 
o Smooth tool for smoothing rough edges 
o New faceted repair tools for fixing holes and sharps 
o Dedicated Separate and Join tools for separating mesh objects into connected sets 
o Merging and splitting of open mesh objects 
o Non-uniform scaling 
o A Thicken tool for thickening a faceted surface 
o Regularize tool for evenly spacing a selected set of facets 
o Thickness and Overhang analysis tools for analyzing characteristics of a mesh 
o Mass property and area calculations  

• Manufacturing prep tools. Specifically: 
o Deburring Toolpath tool for creating an offset toolpath from a set of connected edges 
o Turn Profile tool for generating tool paths from revolute faces 
o Relief tool for automatically finding and adding corner reliefs to flat parts 
o Wrap tool for folding solid and surface geometry around other solids 
o Curve table tool for creating a table of text definitions for a selected set of curves 

• Powerful modeling enhancements such as: 
o Improvements to Pull/Move of surface edges 
o Blend surface controls 
o Round re-ordering  
o Variable radius round improvements 
o Performance 
o Point projection with dynamic update 

• Sheet metal improvements such as: 
o Swept walls 
o Improved bend modifications 
o Rounded louvers 
o Power selection  

Junction improvements
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Notes 
Languages: 
 
You should switch to the English locale if you want to test the new translators. 
 
The translators in SpaceClaim 2015 Beta do not work correctly for non-English locales (basically, any 
foreign language locale that uses a comma instead of a period as a separator, which includes countries 
like, France, Germany, Italy, Poland, etc.).  
 
On the Win 8.1 32bit OS in all languages, some assembly models won’t open in SpaceClaim for all 
translator file formats (i.e. CATIA, PS, NX, Inventor, etc….).   
 
 
ACIS: 
 
ACIS R25 does not support 32bit on Windows 8.0/8.1 OS’s. Only 64bit is supported on Windows 8.x.   
 
This means there is no support for: 
 

• Windows XP (32 & 64bit) 
• Vista (32 & 64bit) 
• Windows 8.0/8.1 (32bit) 

 
The 64bit version on Win8.1 works fine. 
 
CATIA V5: 
 
SpaceClaim 2015 no longer supports reading of CatiaV5 files created in versions older than CatiaV5R8 
 
TraceParts: 
 
Inserting parts from the TraceParts web page is not working. If you want to use TraceParts files, you will 
need to use the TraceParts web download option. 
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Pull 
Pivot Edge direction is now remembered in Groups. Previously, as shown in the example below, the 
direction could flip. The left image shows the initial ruler dimension added to the group. The right image 
illustrates the old behavior. After changing the group value and then clicking in white space, the 
direction flipped when the group was re-opened. 

 
You can now Pull Face-Face rounds and match their radius to other rounds using Up To. Some examples 
are shown here. 
 
 
 
The first example matches an 
interior round to the exterior 
round radius. 
 
 
 
 
 
 
 
 
 
 
 
The second example 
shows a Face-Face 
exterior round. 

 
 

 
You can now rotate 
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multiple coplanar faces to create a solid. Previously, you could select the faces and an axis to rotate 
about, but the rotation would produce no result.  Now, as seen in the example below, the faces rotate 
into a solid. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Pull tool no longer defaults to Rotation after a non-translation tool guide selection. Previously, if 
you did the following: 

1. Enter the Pull tool 
2. Click the Sweep tool guide 
3. Select a trajectory 

4. Click the Select tool guide 
 
the tool would switch to Rotation mode. Now, the tool stays in Sweep mode. 
 
 
 
 
 
 
 
The keyboard Nudge shortcuts (using Ctrl) no longer 
create copied surfaces instead of Pulling the part at 
the large Nudge value. Previously, you could get the 
result shown on the right. 
 
 
 
 
 
 
 
Round modification is being enhanced. Some modifications fail because the entire round chain (along 
with all chains required to be removed by the modification) are all  included in the modification. In some 

Full Pull 

 www.SpaceClaim.com Page 4 



 
   SpaceClaim 2015 Release Notes 

cases, parts of the chain (or others, even far away ones) are restricted by surrounding geometry and the 
modification fails. Now, to make modifications more robust, they are localized to the selected piece of 
the round.  
 
A key to this working is that the ends of the localized section need to be “auto-capped”. In other words, 
they need to be able to be closed off by a plane triangular face, essentially normal to the last-visited 
construction edge. The following example illustrates this. 
 
 
The radius is going to 
be increased at the 
selected edge. 
 
 
 
 
 
 
 
 
 
 
 
 
Localizing means that the round pieces on either side of the edge are removed first. For this to work, the 
ends of the removed pieces need to be “capped” with a triangular face or be the start or end point of 
the round chain. These end conditions are necessary to rebuild the new variable round between the 
ends. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Localized round is reconstructed with the modified radius. 
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The red circles highlight points where there is ambiguity for 
capping the end. IT’s difficult to construct a capping face normal 
to the construction edge. 
 
With Localization, the modification will fail if either of these 
edges is an end of a modified piece of the round. 
 
Without Localization, the modification would include these areas 
and the modification would fail. 
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In order to remove a round for modification, the side faces need to be able to Extend up and form a 
sharp edge.  
 
 
 
 
 
In some cases, extra surface patches can cause ambiguous situations where the sharp edge cannot be 
determined and the round cannot be removed for modification. The image below is an example of a 
round that cannot be removed because of face extension ambiguity. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Round Options have been added to the Pull tool. Edit as 
Variable Radius Round has been moved from the RMB to 
Round Options.  
 
 
 
The Smooth option becomes enabled for constant radius rounds when the geometry allows it. 
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The Smooth option for creating Variable Rounds is ‘sticky’ across tool usages. Once you set it for one 
round, it will remain set for all subsequent rounds, until you change it. Click an edge of an existing 
constant round that can be made to vary smoothly, check the Smooth option and then Pull. The option 
will remain checked for subsequent round modifications. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

Click another constant edge 
and Pull. The Smooth option 
remains active. 

Check Smooth and Pull 
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For periodic round faces (faces that go ‘all-around’), the second variable radius handle is now created 
automatically. You no longer need to add the second handle by clicking on the tangent Pull handle and 
dragging or entering a value (image below right). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
The Thicken option now works correctly when using Up To and pulling surface faces. An example is 
shown below. Previously, pulling the face on the left Up To the face on the right would create a solid 
body in between the faces. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Pull Up To this 
face 

Bottom face is extended and 
no surfaces are thickened 

Old behavior 
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You can now drive a dimension to zero when a modification is tied to a spark dimension. An example is 
shown below. The red face is being pulled up which causes the spark dimension to shrink. Previously, if 
you entered “0” for the dimension, the modification failed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
When a Pull operation results in the selected face separating into individual faces, the resulting faces 
remain selected. Previously, only the face containing the pick point of the original selection remained 
selected. The example below shows the new behavior.  
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Change 0.778 to 0 

Pick point for selection 

Face separates into 
four faces when pulled 
upwards a little 

Faces remain selected 
so pulling again pulls 
them all 
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You can now reverse the order in which a selected round is created. The order in which rounds are 
created influences the appearance and quality of the resultant geometry. You can change the order of 
round creation to clean up split rounds that produce extra edges, as shown in the example below. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Round an edge that is broken by 
existing rounds 

Reverse the order to clean up the 
round 
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Surface edges now correctly extend Up To a datum plane. The images below show an example. 
Previously, when you clicked the Up To option and selected the datum plane, the operation failed. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
You can now toggle between Tangent and Natural (curvature continuous) extension when dragging the 
end of a curve. To drag the extension Tangent to the curve, press and hold Ctrl prior to dragging. You 
can release the Ctrl key once you start dragging. If you do not press Ctrl, the extension is created 
Curvature Continuous. 
 

• Works for Splines (extended or trimmed-back) 

• Works for Arcs 

• The drag behavior has been improved in terms of speed of change versus drag cursor movement 
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

  

Click the Up To option 
and select the plane 

Press Ctrl to drag 
Tangent to the 
curve 

Without pressing Ctrl, 
the drag follows the 
natural curvature 
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Rounds that roll over other rounds now adapt smoothly while pulling. The images below show the old 
behavior. Beginning with the image on the left, pulling the round smaller and then larger would cause 
the rounds to separate strangely.  
 

 
 
 
The images below show the new behavior. Beginning with the image on the left, pulling the round 
smaller and then larger causes both rounds to update smoothly throughout the Pull.  
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
Surface edges can now be Pulled normal to their neighboring face. Press the Ctrl key 
when you begin the Pull. In the Sphere on the right, this results in a new cylindrical 
surface face that is tangent to the original sphere. 
 
 
 
 
 
Previously, The new surface could only follow the 
spherical contour of the original. 
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Move 
You can now drag a vertex of a planar surface as if it were a sketch vertex. 

 

An open corner can 
be moved in two 

directions or moved 
freely within the 

plane. 
 

 

A vertex shared by 
two surfaces can be 

moved along the 
common edge. 

 

 

A vertex shared by 
three surfaces has no 
degrees of freedom. 
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You can now pivot the edges of two planar surfaces about a point. Previously, you would get a message 
that the objects could not be moved. 
 
 

 
 
 
 

 
When in Section mode, you can now anchor the 
Move Handle to axes and temporary axes in the 
section. Previously, in the example shown here, 
if you moved the handle anywhere else in the 
section, you could not move it back to the 
center axis.  
 
 

Points 
 
You can now project sketched 3D Points onto 
surfaces using the Project tool. In the example, 
points were sketched to trace out the shape of a 
mouse button and then projected down onto the top 
surface of the mouse. The workflow is the same as 
projecting Faces, Surfaces, Curves, Edges, or Note 
Text. 
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Sketch 
You can now Anchor the Move Handle to the midpoint of a sketched three-point arc. Previously, 
selecting the midpoint on the arc would anchor the Move Handle to the arc center. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Split Face 
 
 
You can now Split Faces using Curves, 
whether they are touching the face or 
not. Connected curves can be used as 
the cutter by holding the Shift key. An 
example is shown to the right. 
 
 
 
 

Project 
When you project Points using the Project tool, Datum Points are created, instead of Sketched Points, so 
that the projected points can be Pinned. 
  

 www.SpaceClaim.com Page 16 



 
   SpaceClaim 2015 Release Notes 

Sheet Metal 
 
You can now rotate walls whose bends are partially cut out. An example is shown below. A simple L-
shape part is unfolded and a cut is made in the flat. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

You can now Power Select sheet metal Miter 
Corners. 
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Forms: 
 
There is a new Form for creating Rounded Louvers. 
 
It has the following parameters: 

 
• H – Height 
• L1 – Long length 
• L2 – Short length 
• R1 – Round radius underneath 
• R2 – Round radius on top 

 
 

 
 
 
 
 

  
 
 

Fold Walls Tool: 

For unfolded parts, there is now a Fold Walls   tool. You can select Bends individually, by clicking 
on the Bend area – not the wall, or by using box-select. 
 

 
 

 
You can also use the Bend percentage option to partially bend a wall. 

R1 

R2 
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Pull and Move: 

You can now Move and Pull walls in the cases shown below to increase the distance and bend radius 
between the walls. 
 
To create these cases: 

1. Create 180 degree bends  
2. Use a perpendicular bend line to create the parallel case, or an angled bend line to create the 

angled case 
3. Pull or Move one of the walls to increase the gap 
4. The wall will detach briefly but then the Bend will update 

to the new distance 
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Bend Tool: 
 
When creating a Bend using the Select Two Cutter Points tool guide, the bend line is previewed after 
the first point is set (by clicking or entering a value). 
 
 
 
 

o The line previews as you drag the 
cursor to set the second point 

 
 
 
 
 
 

o The bend extents are displayed 
when the cursor reaches 
another edge 

 
 
 
 
 
 
 
 
 
 
 
When a Bend is made and a Hinge is present, 
the Hinge and related walls now follow the 
bending up.  
 
 
 
 
 
 
 
 

 
 
 
 
 
Partial bends now unfold properly when the part has Gussets. 
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Bend Notches no longer adjust when different bend allowances are 
applied to the bends of the Notch. Previously, if you changed the 
bend allowances, the Notch would appear warped in the unfolded 
model. You could reset the Notch but that would also reset the 
bend allowances to their original values. Now, the Notch settings 
and Bend Allowances can be changed independently. The image on 
the right shows an example of a Bend Notch. 
 
 
Repairing inaccurate Bends now works differently. Previously, SpaceClaim would simply identify cut 
bend faces that were not perfectly offset from each other or other faces not nicely paired, and recreate 
the Junction from scratch.  Now we have the additional capability (behind the scenes) to also Replace 
Faces in repairing them. 
 

 
You can now change a Bend radius if an edge relief is 
present. Previously, in the model shown below, you 
could select the Bend and enter a new radius value (e.g. 
change 0.08 to 0.0394) and it would be ignored. Now, 
the bend radius can be changed to 0.0394. 
 
 
 
 
 
 
 
 
 
 
Sheet Metal Options: 
 
A new Junction gap field has been added to the Sheet 
Metal page of SpaceClaim Options. This is currently UI-
only with no functionality attached.  
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Sheet Metal Properties: 
 
With a Sheet Metal part selected, the RMB now has an Export Sheet Metal Properties command. It 
opens the Export Sheet Metal Properties dialog for writing a CSV file. The file has columns for the 
following properties. 
 

• Thickness 
• Area of the flattened part 
• Perimeter of the flattened part 
• Maximum X and Y extents of the flattened part 
• Number of Holes 
• Number of Bends 

 
You must first Unfold the part to have the flat properties export. 
 
 
Junctions: 
 
You can now enter a Percentage for Partial Overlap Junctions. Previously, you could only create Full or 
Half overlap. 
 
Overlap Proportion has been added to the Sheet Metal Properties of Partial Junctions. By default, the 
percentage is 50, which you can change to anything greater than 0% (0.0) and less than 100% (1.0). 

 
 
 
 
 
 
 
 
 
 
 
 
Flange junction conversion has been 
improved.  
 
Converting Full Overlap junctions to Bends has also been improved 
 
 
The Junction gap option in the Sheet Metal page of SpaceClaim Options now works correctly. Previously, 
if you entered a new value, it was ignored. The only way to change the values was to select the Junction 
and change its properties. 
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Bend Tables: 
 
There is a new option in Bend Tables. Use:  
 

KFactorFallback=true/false 
 
to control what happens when an invalid VeeDieWidth is encountered in a Bend Table applied to a 
model. 
 
When set to True, the K-Factor is used. When set to False (the default), the bend fails. 
 
 
Bend Tables containing errors are now handled differently. Previously, the load would abort and no 
bend tables would be loaded. Now an error message is shown and the load continues. 
 
 
 
Sheet Metal Sketching: 
 
A problem has been fixed with sketching sheet metal 
walls using the Profile option. Previously, if you 
sketched the U-shaped profile on the right using RMB > 
Switch to Arc and RMB > Switch to Line, the system 
would create three separate bodies. Now, as long as all 
segments are tangent, only one body is created. Non-
tangent segments are created as separate bodies. 
 
 
Swept Edge Forms: 
 
To create a Swept Edge Form: 

1. Sketch a profile at an endpoint of the edge 
2. Enter the Pull tool 
3. Click the Sweep tool guide 
4. Click the Full Pull tool guide 

 
 
 
 
 
 
 
 
 
 
 

 
 

Full Pull sweep of a line 
profile along an edge 
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Notice that the sweep profile is a single line and an Inside Radius arc is automatically added to the 
profile, at the attachment point, to produce a bend. If the user draws a tangent arc along with a line, 
then that arc determines the bend radius and overrides any IR automation that is done in the case of 
only a straight line. 
 
 
 
 
Swept Edge Forms can also now be unfolded. 
 
 
 
 
 
 
 
 
 
Gussets: 
 
Gussets now center correctly on non-90° Bends. 
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Detail 
It was possible for a document to have more than one Drawing. This occurs when an external 
component with a Drawing is Internalized in a design that also has a Drawing. In this case, it was 
possible (with drag and drop) to move a view from one of the drawings to another. The functionality is 
not stable and has been disabled. 

 
While creating a Leader, hold the Shift key to snap the Leader to the nearest 45° increment. 
 

1. Click to set the start point of the Leader 
2. Start dragging to get near the desired orientation 
3. Press and hold the Shift key 
4. The Leader snaps to the nearest 45° increment 
5. Continue holding Shift down and dragging to set the length 
6. Click to set the endpoint of the Leader 

 
 
You can now toggle a Leader to underline its attached text. If the Leader is attached to the Note’s 
underline location, you can use the RMB to extend the tail of the Leader and underline the text. 
 
 

1. Create a Note 
2. Attach a Leader to the underline location 
3. Exit the Leader tool 

 
 
 
 
 

4. Select the Leader 
5. RMB > Underline 
6. The text is underlined 

 
 
 
 
 
 
 
 
 
 
 
Now, when you select the endpoint of a dimension 
extension line, the dimension it belongs to is 
highlighted. Previously, there was no way to know 
which dimension extension you were modifying. 
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ISO Foreshortened dimensions now display and move correctly when switched to JIS standard. 
Previously, after creating and moving an ISO Foreshortened dimension, if you switched to JIS standard, 
you would have to reposition the dimension. 
 
 
 
When creating Layout Curves in a drawing, the Create curves 
shown only in current view option now works correctly. 
Previously, if you created Layout Curves in a view and then 
created a new Projected View from the current view, the curves 
would be shown in the new view. 
 
 
 
Chamfer Dimensions: 

o Works for planar-planar and planar-cylinder chamfers 
o Flip Chamfer Dimension property toggles the orientation of the dimension 
o Example of each chamfer type is shown below 

 
 
 
 
 
Create a Chamfer Dimension by selecting the Chamfer 
face and moving to an orientation that displays the 
dimension. 
 
 
 
 
 
 
 
 
 
 
Set the Flip Chamfer Dimension property to True to flip the 
orientation. 
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There are two visual styles for Chamfers. 

 

• Normal to the Chamfer face 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Linear dimensions 
 
 
 
 
 
 
 
Change the style in the General page of SpaceClaim Detail options. 
 

 
 
 
 

 
 
There is also a setting to change the Chamfer format to C<length> instead of 
<length>X 45. 
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GD&T 
 
The Structure Tree now has a GD&T folder. 
 
Features of Size and their Dimensions are now shown in the Structure tree. The image below shows 
some different Features of Size displayed in the tree. 
 
Dimensions for Features of Size are also represented in the Structure tree. Expand the Feature node to 
see the dimensions and other GD&T related items. 

 

 
 
Feature of Size Dimensions shown in the tree are the Dimension Representation 
for the Feature, which is different than the graphical representation shown in 
the Graphics Window. 
 
Deleting the dimension in the Graphics Window does not delete the Dimension 
Representation. 
 
So, Features of Size can now only be deleted by explicitly deleting their 
dimension from the tree.  They are no longer automatically deleted when their 
last Feature Control Frame and Datum Features are deleted. 
 
 
 
 
 

Deleting this Width 
dimension will delete the 
Slot Feature of Size. 
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You can now create Basic dimensions between Datum Reference 
Frames (DRF’s) and Tolerance Zones – also referred to as 
Features. 
 
For a selected Feature, the RMB contains a Create basic 
dimensions command, which automatically determines the Basic 
dimensions from the DRF to the Feature. All you need to do is 
place them. 
 
Note that the command will not be available for every Feature in 
the tree. Features that define the DRF do not have basic 
dimensions. So, the Create basic dimensions command is not 
available when any of them are selected.  
  
 
 
Depending on the selected feature, different sets of dimensions can be available for different coordinate 
directions. Tool guides allow you to switch between the directions while placing the dimensions. 

 
 
 
 
 
 
 
 
 
 
Upon entering the tool, if an annotation plane can be determined, it will become the default. If one 
cannot be determined, you will need to select one. 
 
At any time during the process, you can change the annotation plane. 

• Changing the plane may change how many dimensions are available for placement 
 
You can also change which dimension to place while placing a dimension using the tool guides. 
 

 www.SpaceClaim.com Page 29 



 
   SpaceClaim 2015 Release Notes 

Composite Features - those which span a continuous set of faces and shown as Feature   
in the tree - require several basic dimensions. An example is shown below where four faces were 
selected to create a Profile Surface tolerance.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Basic Dimensions for all the edges of the four faces are shown below. 
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Basic dimensions for Slabs and 
Slots dimension to the mid-plane.  
 
 
 
 
 
 
 
 
 
 
 
Basic Dimensions can be made for cylindrical faces in Composite Features. 
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Angular Basic Dimensions are also supported. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Measure 
 
 
 
 
 
 
When measuring Edges and 
Curves, you can see the Minimum 
and Maximum Curvature points 
by hovering over the 
measurement in the results popup 
table. 
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The exponent “^1” has been removed from the unit symbol when the exponent is 1. Some examples of 
where this occurs are Curvature, Centroid X & Y, and Shear Center measurements. The images below 
show the difference for Curvature. 

 
 
 
 
Minimum Distance and Minimum Distance to Axis now work for mesh vertices. 
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Repair 
Two new tools have been added to the Fix group in the Repair ribbon.  
 

Overlapping Faces finds faces that overlap but does not Fix them yet. 

• False positives are filtered out 
 
Bad Faces finds faces that are bad but does not Fix them yet. 

• Bad edges flagged in facet creation are shown 

 
The Overlap Faces tool now uses multi-threading. Depending on the processor, overlapping faces can be 
found up to 10X faster. 
 
 
A Clip Volume checkbox has been added to the Navigate group. 
 

• It acts to create Clip Volume spheres around all the current Repair errors. 
• The forward and back arrows act the same as before, navigating between 

the found errors - optionally Zooming to Fit - but now they are smaller. 
• The small Select icon converts the current error to a real selection for 

defining the Clip Volume (and necessarily exits the current find tool – for manual fixing) 
• Eases the identification of errors buried deep within complicated models 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

Errors found 
Navigate to an error 

Clip Volume On Zoom in 
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Fit Curves 
 
 
The Fit Curve tool now has a Correct tangency option, which does a 
dramatically better job fitting Arcs, as shown in the example below.  
 
Other examples can be found here: 
\\192.168.2.17\depts\R&D\Justin\Mesh curve fit samples\ 
 
 
This example does NOT correct tangency. Notice that only one 
tangency is created at one end of the curves.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
This example corrects tangency and produces tangency between all of the selected curves. 
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Prepare 
A Short Edges tool has been added to the Analysis group in the Prepare ribbon. This is a partial 
implementation that finds edges smaller than a specified length. Small edges reduce the quality of 
meshes used for FEA and CFD applications. 
 
 
Midsurface Face Thickness has been added to Power Selection, for both faces and bodies. 
 
 
The Imprint tool now supports: 
 
 
 

• Body intersections – coincident faces that belong to 
intersecting bodies 

 
 
 
 
 
 
 
 

• Body coincident faces – 
Faces on separate bodies 
that are coincident 

 
 
 
 
 
 
 
 

• Plane-Body coincident faces – faces of a body that lie 
within a plane 
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Facets 
 
The Mesh ribbon tab has been renamed to Facets. 
 
Holes Tool: 
 
There is a new Holes tool in the Cleanup group of the Facets tab. 

• Find-and-fix workflow 

• You can choose between Patch (smooth) and Cap (flat) filling of the holes  

 
 
In the mouse example below, the button needs a 
smooth fill and the bottom simply needs to be 
capped. 
 
 
The Holes tool finds to areas to fix. 
 
 
 
 
 
 
 
Click the Exclude Problem tool guide and select the bottom hole. 

• If you have multiple holes to exclude, you can use box-selection 
 
 
 
 
 
 
Choose Patch in the options and 
click the Complete tool guide. The 
button area is filled with a smooth 
patch. 
 
 
 
 
 
The bottom is found again. Select the Cap option and click Complete to fill 
the bottom with a flat mesh. 
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Separate All Tool: 

The Separate All tool has been added to separate all shells in a mesh. It works like the Separate tool but 
converts all shells into separate mesh bodies. The separate tool only converts one shell at a time.  

 

Separate All Pieces has been changed to Separate Pieces and has been removed from the RMB. 

o Tool Guides have been added for Separate Pieces and Separate All Pieces 
o Only meshes that can be separated are selectable 

 
To separate pieces 

1. Click Separate Pieces in the Cleanup group of the Mesh tab  
o Tool Guides appear 
o Options are available (placeholders for now) for Connected and Over-Connected meshes 

2. Choose Separate Pieces (default) or Separate All Pieces 
3. Select the mesh 
4. The mesh separates and the pieces display in the tree 

 
The Organize group has been rearranged. 
 

• Split All has been renamed to Separate All 
• 24 x 24 icons for Separate, Separate All and Join 
• Separate All has been put in a drop-down menu under Separate 

 
 
 
 
 
 
 
 

 
Join Tool: 
 
The Join tool has been added to the Organize group. It joins meshes that 
have been separated using Split All and/or Separate.  
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Merge Tool: 
 
The Merge tool now works on two Open meshes to automatically create the union that results in a 
single, closed mesh. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

Split and Boolean Tools: 
 
Split and the Mesh Boolean tools (Merge, Subtract, and Intersect) now allow selection of objects in the 
Structure Tree. 
 
 
 
 
Smooth Tool: 
 
The new Smooth tool, and its options, can be used to smooth out an existing mesh. 
 
Smooth is not a one-and-done operation. You can execute the command multiple times, producing a 
finer mesh with each click. 
 
This technique has two different applications: 
 
 
 
 

• Use it to smooth a mesh that is only 
slightly rough 
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• Begin with a rough control mesh and produce something very smooth 
 

 
Smooth Options 
 

 
 
 
 
 
 
 
 

 
 
Angle Threshold determines if an angle stays sharp or gets “smoothed”. 
 
The example below shows an example of a block with all 90° edges except for two which are 45°. With 
an Angle Tolerance of 60°, only the two 45°edges will get smoothed and the 90°edges are left alone. 
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Smooth type determines which smoothing algorithm is used.  
 
Approximate: 

• The original vertex positions and the new vertex positions are allowed to move 
• The amount of movement depends on how smooth the surroundings are 
• In sharp areas, the amount of movement will be large 
• In smoother areas, the amount of movement will be barely noticeable 
• Because of the movement, the Approximate algorithm will, in general, produce 

smoother results 
 

 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
Notice that, with the Approximate method, vertex movement allows the final shape to deviate more 
from the original shape. 
 

Local: 
• No new vertices/facets are created 
• The algorithm operates locally to “knock down” spikes 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Three Approximate operations 

Convert to more facets Three Local operations 
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Regularize Tool: 

The Regularize tool    has been added for making aspect ratios more consistent in mesh bodies and 
selected facets. An example of using the tool is shown below. The aspect ratios of all of the triangles are 
brought closer to each other to reduce the differences between facets in the selection. 
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Thickness Tool: 

The Thickness tool now has a 3D Printing Direction tool guide 

o Use it to set the normal direction representing 
the machine vertical 

 
 
 
 
 

 

 
Overhangs Tool: 
 

A new Overhangs tool     has been added to the Analyze group. It detects and highlights areas of 
the mesh that protrude out at angles up to 90°. You can set the angle to look for in the Options panel by 
entering a value between 0 and 90. The example below is at 65°. These overhangs need to be 
considered when setting the model up for 3D printing. 
 
 

 
 
 
 
 
 

 

 
 
Convert Tool: 
 
Multi-threaded faceting is now used for STL export and Mesh > Convert. 
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Mesh Highlighting: 
 
The highlight scheme (Classic, Default and Custom) for Meshes has changed to match the scheme for 
Bodies.  
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
Edge and face preselect and select highlight have also changed. 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can now use Ctrl+Alt+Shift+H as a shortcut to change the Mesh highlight scheme. 

Custom Highlight  Custom Selected  

Body pre-highlight Mesh Pre-highlight Body pre-highlight Mesh Pre-highlight 
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Selection: 
 

• Use Shift+Double-click on sharp edges to select a set of 
mesh edges that form an isoline – edges that are nearly 
continuously tangent to each other as the line 
propagates.  

 
The selection will be the best polyline found and not 
necessarily a complete loop. As you can see here, the 
selection stops at the cylinder because it is adjacent 
edges are not within some tolerance of “tangent”. 

 
 
 
 
 
 
 
 

• Use Ctrl+Shift+Double-click on sharp edges to 
select multiple mesh edge isolines 

 
 
 
 
 
 
 
 
 
 
 
 
 

• Use Double-click on Boundary mesh edges to highlight and 
select the boundary edges 

 
 
 
 
 

• You can now Select-All from a seed selection using Ctrl+A 
• You can now Invert the selection using Ctrl+Shift+I 
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Pull/Move: 
 
The Pull tool now works with selected mesh facets. Note that triangles at the boundary are simply 
stretched to connect the new and the old triangles in these cases. 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Non-uniform scaling of meshes now works by allowing the X, Y and Z 
directions to be toggled On/Off. 

 
 
 
 

Pull 

Pull 
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The Pull and Move handles now orient themselves to the face-wise normal of the selected facets. 
 
 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Move tool axes now align on Alt-selection of a mesh edge. 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Move tool can now be used on Faces, Edges, and Vertices. 
Previously, you could only use Move on mesh bodies to move and 
create copies of the body. 
 
 
Alt-selection for direction, and Up To for distance, can also be used.  
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Moved mesh faces are recognized in copied 
components. This is the same behavior as 
solids and surfaces. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
You can Move selected mesh edges, whether 
boundary loops or isolines. 
 
 
 
 
 

Measure: 

• You can now use the Deviation tool to do mesh-to-mesh comparisons. Previously, you could 
only compare a mesh to a solid body. 

• Mass Properties now works for meshes and is enabled through the Options>Debug panel in 
SpaceClaim Options 

• The Select Bodies tool guide now selects mesh bodies and not mesh points 
• Meshes are included in the analysis when selecting components in the Structure Tree 
• Measurement values are now correctly rounded off 
• Measure now treats open meshes like surface bodies 

o Only calculate surface area 
o Does not allow a mixed selection of solids and closed meshes 

• You can now measure the area of selected facets 
• The area of a selected facet or of an area selection of facets is now displayed in the Status Bar 
• Selecting a mesh body in the Measure tool now reports the total area of the body 

o Works correctly for a mesh that has been uniformly scaled 

o Works for transformed components 
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Replace Tool: 
 
You can now use the Replace tool on a selected set of facets with a surface. Previously, mesh facets 
could not be selected in the tool at all.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fill Tool: 
 
Fill now works on selected mesh boundaries.  

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
 
 
 
Loops (i.e. holes) in meshes can be 
Filled with triangles that consider the 
curvature of the neighboring facets. 
This produces a very smooth and 
uniform Fill. The newly created facets 
are added to the selection set afterwards. 

Fill selected loop 

Replace 
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Multiple loops can be filled at once in three cases. 
 
 

o Separate loops on the same mesh object that are NOT intended to be joined 
 

 
 
 
 
 
 
 
 
 
 
 

 
o Separate loops on the same mesh object that ARE intended to be joined 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

o Separate loops on different mesh objects that ARE intended to be joined 
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Loops on exterior and interior shells, when filled simultaneously, will create a wall thickness. Fill the 
interior and exterior loops separately to continue the shell. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
Enclosure Tool: 
 
The Enclosure tool in the Prepare tab has been enabled for mesh 
objects. It has only been enabled for use with mesh objects. It does 
not work with the Update functionality. 
 
 
 
 
 
 
 
 
 
 
 
 
Volume Extract Tool: 
 
 
The Volume Extract tool in the Prepare tab has also been enabled 
for mesh objects with color change and leak detection. 
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General: 
 
All tessellation options in SpaceClaim File Options have been standardized. 
 

• Angle deviations for Coarse, Medium, and Fine are now 16°, 8°, and 4° respectively 
• A problem in OBJ options has been fixed so that the slider and text fields update correctly when 

a different preset is selected 
• The VRML option page now displays the Angle the same as other formats (e.g. 16° where it was 

displayed as 16.0000) 
• A problem has been fixed with VRML options so that now when you change the preset and then 

save the settings, the correct preset is written to the file 
 
 
You can now assign Material Properties to selected mesh bodies. 
 
Mesh material properties are preserved after operations such as: 
 

• Copy/Transform 
• Move to component 
• Mesh Boolean operations 
• Reduce 

 
Material ID is maintained for the following: 
 

• Mesh > Export 
• Conversions between mesh and solid 
• Converting from simple mesh to connected mesh 
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Manufacturing 
 
Deburring Tool: 
 
There is a new Deburring tool in the 
Manufacturing group of the Insert tab.  

• Creates an offset curve profile representing the center of a tool 
traversing a set of edges 

• Using the tool options, you can change the tool radius and the 
width of the cut 

 
 
 
 
 
 
 
 
Wrap Tool: 
 
There is a new Wrap tool in the Manufacturing group of the Insert tab. 

• Allows wrapping of solids around other solids 

• Preview is shown as curves 

• Works with bodies and faces 

o With a face selected, the Wrap Bodies option will 
wrap the entire body that the face belongs to 

o With a face selected, the Imprint on Target option 
will imprint the face 
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• Multiple target faces (or an entire other solid) can be selected to Wrap or Imprint 

o The image below shows an example of a solid wrapped around many faces 

o You can select multiple solids to wrap at once 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

• Sketched Curves can be wrapped. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Notes can also be wrapped. 
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• Solids are created after wrapping even if the source faces are at different heights 

o The example below has three solids “sandwiched” together 
o All three solids are wrapped at the correct heights 
o Imagine a circuit board wrapped onto a solid 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Wrap tool allows manual alignment of Targets and Sources by dragging the Start Point on the 
Target. In the example below, the wrapped object needs to be positioned at the intersection of the two 
axes on the Target. So, the first step is to reposition the Start Point on the Source to a more convenient 
location, near the desired result. Drag the Start point and place it on the Source somewhere in the lower 
left corner. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Three different heights 
produce three different solids  

Start Points  
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The image below shows the repositioned Start Points. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
As you drag the Start Point on the Target, the Wrap preview dynamically updates to show where the 
Wrap will be created. In the image below, the Start Points have been dragged back and to the right to 
have the Wrap edges line up with the axes. 
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The image below shows the result, after clicking Complete. 
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Turn Profile Tool: 

There is a new Turn Profile tool     in the Manufacturing 
group of the Insert tab. 

• Works for cylindrical bodies 

• NOTE – You must align the cylindrical body along the Z-
Axis 

 
 
 
 
 
 
 
• Offset curves are 

supported 
 

 

• After selecting a cylindrical face, the tool automatically previews the Profile 
o Click Complete to create the Profile curves 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5mm offset 
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A Curve Table function has been added to the Illustrations group. 
 

• Displays the data points for selected Manufacturing Curves 
 
 
 
 
 
 
 

 

 

 

Relief Tool: 

A new Relief tool has been 
added. 

• Find and Fix tool 

• Looks for thickness 
edges in concave situations 

• Filters out edges that don not go through 

• Finds edges on multiple pairs of thickness faces in the same body 

• Edges found can have a cylindrical cutout made 
to provide relief 

• The size and positioning of the relief can be 
changed in the Options 

 
 
This example has two pairs of thickness faces. 
 

• Notice that the pocket edges don’t go through 
the part so they are filtered out 

• The external corner is excluded unless you 
check Include external corners in the Options 
panel 
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You can change the following options: 
 

• Cut Radius – controls the size of the relief 

• Clearance – controls the position of the Relief by specifying how far the edge of the Relief is 
from the original edge 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1mm Radius 
Default Clearance 

1mm Radius 
1.5mm Clearance 1mm Radius 

1mm Clearance 

1mm Radius 
0mm Clearance 

 www.SpaceClaim.com Page 60 



 
   SpaceClaim 2015 Release Notes 

Graphics/UI/Selection 
 
The Dimension tool now has status messages in the Status area of the SpaceClaim interface. 
 
 
 
 
 
 
The messages are also shown in the Hint area of the Graphics window (upper left corner) 
 

 
 
 
 
The Welcome Window has been redesigned with new 
icons. 
 

• The What’s New section now advertises major 
new functionality with specific links for: 

o LiveReview 

o Mesh 

• All other links are the same as before except 
for the tutorial link in the Getting Started 
section 

o We now link to the Training page on 
our website 

o Previously, we linked directly to the 
Wrench tutorial 
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There have been changes to the correspondence between graphics card capability and the Anti-Aliasing 
settings in SpaceClaim Options > Popular Options. 
 

• Essentially, the old High setting is the new Low setting 

• SpaceClaim now estimates the video card memory available and decrements the Ant-Aliasing 
setting if the graphics card does not have enough capability 

• Available graphics card memory is estimated based on the new screen size as it is reset by 
dragging 

• For the High setting, if the memory limit is reached and exceeded (i.e. the device runs out of 
memory), SpaceClaim turns off Anti-Aliasing and does not crash 

• The images below show the effect of Ant-Aliasing 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
SpaceClaim Options > Popular now contains a checkbox for the Keyshot tab. 
 
Adding “Unknown Material” to the material library no longer deletes library entries. 
 
The “Unknown Material” name is no longer editable. Previously, you could type in a new name but it 
would revert back to “Unknown Material”. 

Anti-Aliasing High 

Anti-Aliasing Off 

 www.SpaceClaim.com Page 62 



 
   SpaceClaim 2015 Release Notes 

 
The cursor now changes when you are in Turntable spin mode.  
 

• Picture the World Origin as a turntable 
o The model sits on the XY-plane 
o The Z-axis is the axis of rotation 

• Spinning is based on cursor movement as follows: 
o Left-to-Right cursor movement spins about the Z-axis 
o Up-and-Down cursor movement spins the XY-plane 

 
• You can see the difference by orienting the World Origin as follows: 

 
o Z-axis horizontal: 

 
 
Cursor movement Left-to-Right spins the model only about the Z-axis 
 
Cursor movement Up-and-Down Also spins the model only about the Z-axis 
 
A combination of both movements Also spins the model only about the Z-axis 

 
• Turntable spin is enabled in the Navigation page of SpaceClaim Options 

 

 
Pre-selection is hidden for any object under the cursor when a Box-select (rectangle, lasso, or polygon) is 
initiated. The previous behavior is shown in the image below left. The new behavior is shown below 
right. When the pre-highlighting was included, it could be unclear what the actual selection will be. 
Hiding the pre-highlighting as the selection box is being created makes it clearer what the selection will 
be. 
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The default size for ALL undocked windows has been changed from 128 x 128 to 300 x 300. 
 
 
 
Protrusions and Depressions can now be selected with the 
RMB in the Mirror tool for faces. This is a shortcut for selecting 
all the faces that make up a Protrusion/Depression. 
 
To mirror a depression 

1. Enter the Mirror tool 
2. Select the Mirror Plane 
3. Click the Mirror Face tool guide 

 
 
 
 
 
 
 
 
 
 
 

4. Select, or hover over, a face of a depression  to mirror 
5. RMB > Select > Depression 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. The Depression faces are selected 
and mirrored 

 
 
 
The process is the same for Protrusions. 
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Line Style, Lineweight, and Line Color are now maintained for copied Layout Curves. Previously, you 
could create Layout Curves in a drawing view, change their properties, and then Copy-Paste them but 
the new properties were not maintained. 
 
 
Keyboard shortcuts are now processed even when the mouse is over the Structure Tree. 
 
Opening files that are already open in a window tab now pops the opened document to the front. 
Previously, nothing happened and you had to look through the tabs to find the document. 
 
 
 
When Pasting a copied component, there is now a 
second Paste option in the RMB. 
 
 
 
 
 
Paste Independent eliminates the need to use RMB>Source > Make Independent after Pasting, which 
could become tedious when repeated. 
 
 

 
 
 
 
 
 
 

  Paste        Paste > Independent 
 
 
 
 
 
You can now store a selection (i.e. create a Group) containing only a Secondary selection. For example, if 
you enter the Pull tool and use Alt to select a face, you can create a group containing only the Alt-
selected face. Previously, there had to be at least one Primary selected object, in order to store an 
Alternate object. 
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The graphics in the tool options panels has been cleaned up. 
 

• Removed drop shadow around each group panel 

• Group panels now fill the width of the container 

• Tuned the color gradients 

• Panel background is now white to be consistent with the structure and properties panels 

• Added generic 16x16 "Gear" icon for tools' general options panel header - updated Pull, Move, 
Fill, Combine, Blend, Volume Extract 

 
The new clean look is shown in the image below left and the previous look is shown in the image below 
right. 
 
 
 
 
 
 
 
 
 
 
 
 
 
         New      Old 

 
 
 
 
In the Application menu, the SpaceClaim 
Options button now has a gear icon. 
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Insert Tab: 
 

• The Manufacturing group has been moved from the Prepare tab to the Insert tab 
• Standard Hole is now in the relocated Manufacturing group 
• Orient Mesh has been moved to the Geometry group 

 
 
 
 
Showing and Hiding large numbers of objects in the tree has been made dramatically faster. One test 
model went from 4 minutes and 32 seconds to just 0.745 seconds! 
 
 
 
 
 
 
Power Selection has been added for Variable radius round faces and 
chains (of faces, even if they are composed of a mixture of constant 
and variable faces). 
 
 
 
 
 
The Table and Hole Table tools have been moved from the Detail tab to the Illustrations group in the 
Insert tab. 
 
The SpaceClaim Viewer can now use OpenGL 3.3.0. 

• Can read SCDOCs 
• Can set different edge thicknesses (by virtue of OpenGL)  in a single pass 

 
 
Clip with Volume (Sphere) has been enhanced. 

• The Center coordinates (from World Origin) are 
now given in model units 

• Coordinates are also truncated to the number of 
digits set in SpaceClaim Options 

• You can now change the location and size of the 
sphere by entering new coordinate and Radius 
values 

 
 
Source > Replace Component now works for multiple selected components. Previously, Source was not 
active when more than one component was selected. 
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Color Changed Faces now shows faces as changed if internal edge loops are changed. Previously, faces 
were colored when their exterior boundary edges changed. In the example below, the exterior boundary 
edges of the top and bottom faces remain the same while the edges of the interior holes have changed. 
Previously, only the holes’ faces would have been colored. Now, the top and bottom faces are colored 
as well. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
In the Find dialog, invoked with Ctrl+F, the order of Wildcards and Regular Expressions has been flipped. 
Now Wildcards is selected first. 
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Import/Export 
 
General Import: 
 
We now import layer information for all supported file types. 
 
ACIS: 
 
We now import ACIS materials which are translated by Interop from another file format like CATIA V5. 
 
 
ANSYS: 

• The order of the Shared Topology settings has changed. 
Share is now before Merge in the dropdown list. 

 
 
 
 
 
 
 
CATIA: 
 
There is a new Import option for CATIA V5. 
 
Map CATIA Geometric sets to SpaceClaim Groups will create 
SpaceClaim Groups that match Geometric sets in CATIA V5.  
 
The images to the right show two Geometric Sets in CATIA V5 
 

• Sketch.1 – contains the connected curves 
• Extrude.1. – contains the surfaces extruded from the curves 

 
When the CATIA V5 model is imported in SpaceClaim, the sets become 
Groups Sketch1 and Extrude1. 
 
Multi-threaded Import is now enabled for CATIA CGR files. Without multi-threading, CGR components in 
CATIA .product files would not import. 
 
 
IDF: 
 

• IDF files can now be “synced” when certain operations occur 
• Currently only Moved-around Components are supported for syncing 
• Use RMB > Update IDF to sync the file after transforming components 

o If the current document was created by importing an IDF file 
o The source IDF file has to be present on disk at its original location 
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• A new IDF file is written that contains updated information 
• The new file can be read back into the originating ECAD system and automatically update the 

components  
 
 
 
 
Synced IDF files support these 
operations: 

• Components moved 
• Components deleted 
• Drilled holes moved 
• Board outlines modified 

 
 
 
 
 
 
 
 
 
JT Import: 

• JT Facets-Only files are now supported 
• Multi-threading has been enabled in both stages of the import (thus showing the multi-threaded 

progress bar) 
• Assembly information from a JT assembly file is uploaded even if the components referred to by 

the file are not present 
• Assembly import now continues in the case of IOP Parasolid to ACIS translation failure 

 
JT Export: 

• Assemblies can now be exported to a JT faceted file 
 
 
JT and PDF: 
 
The JT and PDF pages of SpaceClaim Options now have 
the familiar import settings for faceted models. 
 
The Lightweight option has been removed for CATIA, so 
all facet import options are as shown on the right. 
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OBJ: 
 

• UV’s are now transformed according to a body or face, and texture information is exported with 
the file. An example is shown below. 

 

 
PDF: 
 
3D PDF (U3D format) can now be Imported as 
facets in the same way as CATIA CGR. 
 
A progress bar is shown during import. 
 
Import of curves from faceted PDF file (U3D) has 
been implemented. 
 
 
3D PDF, if geometry is not available (i.e. graphics 
only) 
 
 
 
PMI: 
 
SpaceClaim can now write (some) PMI to SAT/SAB files 
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Rhino: 
 
We now automatically import Mesh from a Rhino file, when there are no B-rep contents present in the 
file. 
 
Rhino import now automatically fixes tiny edges, when the Improve imported data option is checked. 
 
 
 
SketchUp: 
 
The SketchUp SDK has been upgraded to 2014, which includes 64-bit support. This will handle larger 
SketchUp files. 
 
 
Outlook: 
 
Share > As Outlook Attachment now starts a 
new Outlook email with the model attached 
and the Subject filled in. Previously, a bland, 
generic dialog opened. 
 
 
 
 
 
 

Converter 
 
You can now specify a directory for converted files.  
 
 
There is now a command line switch (for SpaceClaim) to check for add-ins 

• CommandLineAddInsOnly will only load add-ins specified by the 
AddInManifestFileName switch 

• For example: /CommandLineAddInsOnly=true 
• The switch is primarily intended for use with the Converter to limit the add-ins loaded 
• The switch can be used to start SpaceClaim without looking for add-ins in the usual locations 

 
 
Options changes: 

• You can now specify an Output directory 
• Email notifications can now be sent for:  

o Errors 
o Convert completion 
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• You can now set a Failure Threshold to trigger an Abort 
 
 
 
 
 
 
 
 
 
Process changes: 

• Pause and Skip buttons have been added 
o Pause temporarily stops the process 

and displays a message that the 
conversion is paused 
 Click the Resume button to 

continue the conversion 
o Skip fails the current model and 

displays Status message naming the 
skipped model 

• Cancel is renamed to Abort 
• SpaceClaim status messages are shown at 

the bottom  
• A running tally total successes and failures is 

displayed while the process is running 
• The image below shows these changes 
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SC Options 
 
UI for Customizing Command Shortcuts has been added.  
 

 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
General Detail Options: 

 
Hide annotations behind model has been added. 

• Hides Annotations behind solid geometry 
• Datum Reference Frames are not affected by the option as they need to be visible 
• Default setting is Off 
• Image below left is Off and right is On 
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LiveReview 
 
All participants now see markup Text as it is typed. 
 
You can now work with Mesh models in LiveReview sessions. 
 
 
 
 
Snapshots can now be deleted on the Client using the RMB. 
 
 
 
 
 
 
On the Client and the Host, snapshots that are not related to the current model are grayed-out. 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
We now synchronize the view between Host and Clients when changing to Perspective mode on the 
Host. 
 
We now use a better default size for the Chat window when it is undocked. 
 

o Changed from 128x128 to 300x300 
o If the you resize the undocked Chat window, the new size is respected in subsequent 

SpaceClaim sessions. 
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Share As Weblink 
 
The website that Weblink connects to has changed. See the image below. 
 

• Gradient background 
• Added SpaceClaim logo 
• Removed File Open button 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Snapshot tool now displays the image in a popup frame for printing, copying, etc. 
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SC Viewer 
 
Andrey.scfiles.com can now read analysis mesh files from Fluent (.msh) and any saved in GLTF format. 
For GLTF, all child files (.bin, .glsl, and .json) in the folder are retrieved. 
 
 
 
 

ANSYS/SCDM 
 
In the Repair tab, new buttons have been added for Overlap Faces and Bad Faces 

• No functionality attached yet 
• These will display overlapping and bad faces respectively 

 
In SpaceClaim, to ensure that dimension updates from Workbench (WB) are robust, the Move handle 
needs to be anchored to something meaningful (i.e. not just the default location). The Ruler Dimensions 
should also be attached to stable objects. If not, then you can get unexpected results or failures. Now, in 
SpaceClaim, a balloon warning/error message is displayed if the dimension update from WB is 
inaccurate or if it fails. 
 
 
Models with many beams and shells now transfer dramatically faster to ANSYS 16. The improvement is 
on the order of 10X faster. 
 
 
Converting surface bodies to mid-surfaces, by entering a thickness in the properties panel, is now up to 
100X faster. A progress bar has also been added. 
 
SpaceClaim can now open directly into the UI of AIM 160 in addition to ANSYS WB 160. 
 
SpaceClaim–to—ANF is now available to WB Schematic. 
 
When transferring models from SpaceClaim to Part Manager (PM), we protect access to PM. In other 
words, if PM is busy accepting a transfer no other models can attempt to transfer until PM is free. 
 
Multi-threading is now used for SpaceClaim—to—PM transfers. 
 
Actions such as tab switching, saving, and model manipulation are now dramatically faster for models 
with large numbers of beam bodies. 
 
The SCDM splash screen is now suppressed when SpaceClaim is invoked directly from the WB schematic. 
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An option has been added to WB to flatten an assembly (i.e. create a single level of individual bodies) by 
exploding multi-body components and sub-assemblies. Below is a description of the situation: 

• WB can only represent models by parts that contain one or more bodies 

• To use multi-threaded part meshing, independent bodies (i.e. bodies that do not share topology 
with other bodies) need to be separated into their own parts upon transfer to WB 

• Eventually, assembly handling and meshing will be enhanced to remove these limitations 

 

 
Transfer speed to ANSYS has been improved by another 10X for a flat structure tree of only surfaces. 
 
The ANSYS 16.0 watermark is now displayed in the graphics window. 
 

 

 
 
Designs with hundreds of named selections now transfer up to 3X faster to ANSYS. 
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API 
 
There is a new add-in for uploading mesh models to MakerBot’s design community called Thingiverse.  
 

 
To upload a model to Thingiverse: 

1. Click Login to login to Thingiverse 
2. A web page opens for you to authorize SpaceClaim to access your Thingiverse account 

• If you do not have an account, you will be redirected to the web page for creating an 
account 

• Then you will be asked to authorize SpaceClaim 
3. SpaceClaim displays a message in the Status Bar when you are logged in 
4. The Login button grays out 
5. The Upload button is enabled 
6. Click Upload to upload the current mesh model 
7. A dialog opens to enter information Thingiverse needs to process your model 
8. When you submit the information, Thingiverse opens the web page containing your model 

• It may take a few minutes for your model to appear as Thingiverse processes the 
information and generates thumbnail images, etc. 

 
 

Add-ins 
 
MakerBot Thingiverse Uploader: 
 

• Opening the browser is now optional 
• The Thing’s link can be copied to the clipboard 

 
 

ACIS 
 
ACIS R25 is now included. 

 www.SpaceClaim.com Page 79 


	SpaceClaim 2015 Beta Enhancements Overview
	Notes
	Pull
	Move
	Points
	Sketch
	Split Face
	Project
	Sheet Metal
	Detail
	GD&T
	Measure
	Repair
	Fit Curves
	Prepare
	Facets
	Manufacturing
	Graphics/UI/Selection
	Import/Export
	Converter
	SC Options
	LiveReview
	Share As Weblink
	SC Viewer
	ANSYS/SCDM
	API
	Add-ins
	ACIS

